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1 Hardware Architecture 1.1 System Architecture

1 Hardware Architecture

1.1 System Architecture

Gowin_ EMPU(GW1NS-4C) is an on-chip system consisting of MCU
core system and FPGA core system, as shown in Figure 1-1.

Figure 1-1 System Architecture

MCU
|TAG IF I
TG Config-Core
oAp L /
Cortex-M3 I
TPIU IF
THIL
Bus Matrix .
FPGA Fabric
. USER INTI[O-5]
I NWIC
AHBZ Slave Extension
i AHB2 Slave SRAM FLASH
AHE AHBZ Master Extension |nH|52 Master
LITE SRAM/FLASH IF
Clock/Reset
AHB24PB K Clock/Reset
APE2 Extension IF
APBL APB2 APB2
Bridge
UARTO IF
Timerd LUaRTO r
— UARTL IF l2c Pl Masi\:"[if 12]
Timerl |- LARTL r
RTC IF
Watch Dog RTC

MCU core system consists of MCU Core, AHB and peripherals,
AHB2APB Bridge, APB1 and peripherals.

FPGA core system consists of the clock and reset signal input, data

IPUG932-2.1E
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1 Hardware Architecture

1.2 System Feature

SRAM, instruction FLASH of MCU core system, APB2 Bridge, APB2 and
peripherals.

1.2 System Feature

Gowin_ EMPU(GW1NS-4C) includes two sub-systems:

® MCU core system

® FPGA core system

1.2.1 MCU Core System

IPUG932-2.1E

MCU core system includes:

® MCU Core:

ARM Cortex-M3 Core, ARM architecture v7-M Thumb2 supporting
16-bit and 32-bit instruction set

DAP (Debug Access Port)

Bus Matrix

NVIC (Nested Vector Interrupt Controller)
TPIU (Trace Port Interface Unit)

® AHB and peripherals

GPIO
AHB2 Master user extension interface

AHB2 Slave user extension interface

® AHB2APB Bridge

® APB and peripherals

UARTO

UART1

Timer0

Timer1

Watch Dog

RTC

APB2 Extension Interface
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1 Hardware Architecture 1.3 System Port

1.2.2 FPGA Core System

FPGA core system includes:

® External crystal oscillator clock input or internal crystal oscillator clock
can be as the system clock source of MCU core system. The max.
frequency of the system clock is up to 200MHz (Subject to the project
design and the chip in use).

® The reset signal input can be as the system reset signal of MCU core
system.

® Six user interrupt handling signals for user extension peripherals
® AHB Extension interface

- SRAM and FLASH can be as the data and instruction memory
respectively of MCU core system

- One AHB2 Master user extension interface
- One AHB2 Slave user extension interface
® APB2 Extension Interface
- SPI Master
- I?C Master
- Twelve APB2 Master user extension interfaces
® Memory
- The SRAM Size can be configured as 2KB, 4KB, 8KB and 16KB.
- The FLASH Size as 32KB.

1.3 System Port

The definition of system ports is as shown in Table 1-1.

Table 1-1 Definition of System Ports

Name I/O Data Width | Description Module
sys_clk in 1 System clock signal -
reset_n in 1 System reset signal -
trace_clk out 1 TPIU clock signal

TPIU
trace_data out [3:0] TPIU data output signal
user_int_ 0 in 1 User Interrupt handling signal 0

NVIC
user_int_1 in 1 User Interrupt handling signal 1

IPUG932-2.1E 3(36)




1 Hardware Architecture

1.3 System Port

Name I/0 Data Width | Description Module
user_int_2 in 1 User Interrupt handling signal 2
user_int_3 in 1 User Interrupt handling signal 3
user_int_4 in 1 User Interrupt handling signal 4
user_int_5 in 1 User Interrupt handling signal 5
gpio inout | [15:0] GPIO signal GPIO I/O
gpioin in [15:0] GPIO input signal
gpioout out [15:0] GPIO output signal GPIO non-I/O
gpioouten out [15:0] GPIO output enable signal
uart0_rxd in 1 UARTO receive signal

UARTO
uartO_txd out 1 UARTO transmit signal
uartl_rxd in 1 UART1 receive signal

UART1
uartl_txd out 1 UART1 transmit signal
scl inout | 1 I°C serial clock signal

I2C Master 1/O
sda inout | 1 I°C serial data signal
sclin in 1 I°C serial clock input signal
sclout out 1 I°C serial clock output signal
sclouten out 1 I2C serial clock output enable

signal

I2C Master non-1/0
sdain in 1 I°C serial data input signal
sdaout out 1 I°C serial data output signal
sdaouten out 1 I°C serial data output enable

signal

mosi out 1 SPI master output / slave input
miso in 1 SPI master input / slave output

SPI Master
sclk out 1 SPI clock signal
nss out 1 SPI slave selection signal
rtc_src_clk in 1 RTC signal RTC
master_hclk out 1 Master clock signal
master_hrst out 1 Master reset signal
master_hsel out 1 Master selection signal AHB2 Master
master_haddr out [31:0] Master address signal
master_htrans out [1:0] Master transmit type signal

IPUG932-2.1E
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1 Hardware Architecture

1.3 System Port

Name I/0 Data Width | Description Module
master_hwrite out 1 I/0 of Master read and write
signal
master_hsize out [2:0] Master transmit Size signal
master_hburst out [2:0] Master burst type signal
master_hprot out [3:0] Master protect and control signal
master_memattr out [1:0] Master memattr signal
master_exreq out 1 Matter exreq signal
master_hmaster out [3:0] Master label signal
master_hwdata out [31:0] Master write data signal
master_hmastlock out 1 Master lock signal
master_hreadymux out 1 Master hreadymux signal
master_hauser out 1 Master hauser signal
master_hwuser out [3:0] Master hwuser signal
master_hrdata in [31:0] Master read data signal
master_hreadyout in 1 Master hreadyout signal
master_hresp in 1 Master transmit status signal
master_exresp in 1 Master exresp signal
master_hruser in [2:0] Master hruser signal
slave_hsel in 1 Slave selection signal
slave haddr in [31:0] Slave address signal
slave_htrans in [1:0] Slave transmit type signal
slave_hwrite in 1 I/O of Slave read and write signal
slave_hsize in [2:0] Slave transmit Size signal
slave_hburst in [2:0] Slave burst type signal
slave_hprot in [3:0] Slave protect and control signal
AHB2 Slave
slave_hmaster in [3:0] Slave label signal
slave hwdata in [31:0] Slave write data signal
slave_hmastlock in 1 Slave lock signal
slave_hrdata out [31:0] Slave read data signal
slave hready out 1 Slave ready signal
slave_hresp out 1 Slave transmit status signal
slave hexresp out 1 Slave hexresp signal

IPUG932-2.1E
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1 Hardware Architecture

1.3 System Port

Name I/0 Data Width | Description Module
slave_hruser out [2:0] Slave hruser signal
slave_hmemattr in [1:0] Slave hmemattr signal
slave_hexreq in 1 Slave hexreq signal
slave_hauser in 1 Slave hauser signal
slave_hwuser in [3:0] Slave hwuser signal
master_pclk out 1 APB2 Master clock signal
master_prst out 1 APB2 Master reset signal
master_penable out 1 APB2 Master enable signal
master_paddr out [7:0] APB2 Master address signal
APB2 Master
master_pwrite out 1 I/O of APB2 Master read and [1-12]
write signal
master_pwdata out [31:0] APB2 Master write data signal
master_pstrb out [3:0] APB2 Master write strobe signal
master_pprot out [2:0] APB2 Master protect type signal
master_psell out 1 APB2 Master [1 ] selection signal
master_preadyl in 1 APB2 Master [1 ] ready Signal
master_prdatal in [31:0] APB2 Master [1 ] read data APB2 Master [1]
signal
master_pslverrl in 1 APB2 Master[ ] transmit failure
signal
master_psel2 out 1 APB2 Master [2 ] selection signal
master_pready?2 in 1 APB2 Master [2 ] ready Signal
master_prdata2 in [31:0] APB2 Master [2 ] read data APB2 Master [2]
signal
master_pslverr2 in 1 APB2 Master[ ] transmit failure
signal
master_psel3 out 1 APB2 Master [3 ] selection signal
master_pready3 in 1 APB2 Master [3 ] ready Signal
master_prdata3 in [31:0] APB2 Master [3 ] read data APB2 Master [3]
signal
master_pslverr3 in 1 APB2 Master|[ ] transmit failure
signal
master_psel4 out 1 APB2 Master [4 ] selection signal
APB2 Master [4]
master_pready4 in 1 APB2 Master [4 ] ready signal

IPUG932-2.1E
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1 Hardware Architecture

1.3 System Port

Name I/0 Data Width | Description Module

master_prdata4 in [31:0] APB2 Master [4 ] read data
signal

master_pslverr4 in 1 APB2 Master[ ] transmit failure
signal

master_psel5 out 1 APB2 Master [5 ] selection signal

master_pready5 in 1 APB2 Master [5 ] ready signal

master_prdata5 in [31:0] APB2 Master [5 ] read data APB2 Master [5]
signal

master_pslverrs in 1 APB2 Master[ ] transmit failure
signal

master_psel6 out 1 APB2 Master [6 ] selection signal

master_pready6 in 1 APB2 Master [6 ] ready signal

master_prdata6 in [31:0] APB2 Master [6 ] read data APB2 Master [6]
signal

master_pslverré in 1 APB2 Master[ ] transmit failure
signal

master_psel7 out 1 APB2 Master [7 ] selection signal

master_pready7 in 1 APB2 Master [7 ] ready signal

master_prdata7 in [31:0] APB2 Master [7 ] read data APB2 Master [7]
signal

master_pslverr7 in 1 APB2 Master[ ] transmit failure
signal

master_psel8 out 1 APB2 Master [8 ] selection signal

master_pready8 in 1 APB2 Master [8 ] ready signal

master_prdata8 in [31:0] APB2 Master [8 ] read data APB2 Master [8]
signal

master_pslverr8 in 1 APB2 Master[ ] transmit failure
signal

master_psel9 out 1 APB2 Master [9 ] selection signal

master_pready9 in 1 APB2 Master [9 ] ready signal

master_prdata9 in [31:0] APB2 Master [9 ] read data APB2 Master [9]
signal

master_pslverr9 in 1 APB2 Master|[ ] transmit failure
signal

master_psell10 out 1 APB2 Master [10 ] selection APB2 Master [10]

IPUG932-2.1E
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1 Hardware Architecture

1.4 System Resource Utilization and Performance Statistics

Name I/0 Data Width | Description Module
signal
master_pready10 in 1 APB2 Master [10 ] ready signal
master_prdatalO in [31:0] APB2 Master [10 ] read data
signal
master_pslverrl0 in 1 APB2 Master[ ] transmit failure
signal
master_pselll out 1 APB2 Master [11 ] selection
signal
master_preadyl1l in 1 APB2 Master [11 ] ready signal
master_prdatall in [31:0] APB2 Master [11 ] read data APB2 Master [11]
signal
master_pslverrll in 1 APB2 Master[11] transmit failure
signal
master_psel12 out 1 APB2 Master [12 ] selection
signal
master_pready12 in 1 APB2 Master [12 ] ready signal
master_prdatal2 in [31:0] APB2 Master [12 ] read data APB2 Master [12]
signal
master_pslverr12 in 1 APB2 Master[12] transmit failure

signal

1.4 System Resource Utilization and Performance

Statistics
The system resource utilization and performance statistics of
Gowin_EMPU(GW1NS-4C) are as shown in Table 1-2 .
Table 1-2 System Resource Utilization and Performance Statistics
Resources . Frequency

Configuration LUTs Registers BSRAMs (MHz)
MCU core system 33 19 4 200
MCU core system + 12C Master + SPI Master 456 282 4 100
MCU core system + APB SPI-Flash Memory 1073 618 4 50
MCU core system + AHB PSRAM Memory 1709 1464 4 100
MCU core ssystem + AHB HyperRAM Memory 1163 1008 4 100

IPUG932-2.1E
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2 Hardware Design Flow 2.1 Hardware Target

2 Hardware Design Flow

2.1 Hardware Target

® DK-START-GW1NSR4C-QN48G V1.1
GW1NSR-LV4CQN48GC7/l16

® DK-START-GW1NSR4C-QN48P V1.1
GW1NSR-LV4CQN48PC7/16

® DK-START-GW1NSR4C-MG64P V1.1
GW1NSR-LV4CMG64PC7/16

2.2 Software Version

Tested software version: Gowin_V1.9.11.02 (64-bit)

2.3 IP Core Generator

The IP Core Generator tool from Gowin Software is used to configure
and generate Gowin_ EMPU(GW1NS-4C) IP Core.

2.4 Programmer

Gowin Programmer tool is used to download the bitstream file of
Gowin_EMPU(GW1NS-4C).

For the Gowin Programmer usage, please refer to SUG502, Gowin
Programmer User Guide.

2.5 Design Flow

Gowin_ EMPU(GW1NS-4C) hardware design flow is as follows:
® Configure and generate Gowin_EMPU(GW1NS-4C) IP Core using IP

IPUG932-2.1E 9(36)



http://cdn.gowinsemi.com.cn/SUG502E.pdf
http://cdn.gowinsemi.com.cn/SUG502E.pdf

2 Hardware Design Flow

2.5 Design Flow

IPUG932-2.1E

Core Generator and import the current project.

Instantiate Gowin_ EMPU(GW1NS-4C), import user design, and
connect user design with Gowin_EMPU Top Module.

Add physical and timing Constraints.

Use GowinSynthesis to synthesize and generate post-synthesis netlist
file.

Use Place & Route to generate bitstream file.

Use Programmer to download bitstream file to chip to chip.
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3 Project Template 3.1 Project Creation

Project Template

3.1 Project Creation

3.1.1 Create a New Project

Double click to open the Gowin Software. Click "File > New... > FPGA
Design Project" on the menu bar, as shown in Figure 3-1.

Figure 3-1 Create a FPGA Design Project

. - & X
L =] B 0
0 KD @®
Recent Projects: (A
Quick Start
W New 70X
¥ Projects "~
_;_,g FPGA Design Project
¥ Files
T .
s g Verilog File L
_& VHDL File
_u Physical Constraints File
Timing Constraints File v
v
Create a FPGA design project.
You will be able to add or create RTL sources, run synthesis, a
lace & route, and device.
e — place & route, and program your device 5 x
o 1o (00 ]
ok ]| care

Conscle  Message
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3 Project Template

3.1 Project Creation

3.1.2 Set Project Name and Path

Enter the project name and select the project path, as shown in Figure

3-2.

Figure 3-2 Set Project Name and Path

W Project Wizard

E> Project Name
Select Device

Summary

Project Name

Enter a name for your project, and specify a directory where the project will be stored. The directory will be
created if it doesn't exist.

Mame: |gowin_empu| |

Create in: |F:,-" |

[ Use as default project location

MNext = Cancel

3.1.3 Select Device

IPUG932-2.1E

Configure "Series", "Device", "Device Version", "Package", "Speed",
and "Part Number", as shown in Figure 3-3.

Take DK_START_GW1NSR4C_QN48P_V1.1 reference design as an

instance.

® Series: GW1NSR

Device: GW1NSR-4C

Device Version: Any

Package: QFN48P

Speed: C7/16

Part Number: GW1NSR-LV4CQN48PC7/16
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3 Project Template

3.1 Project Creation

Figure 3-3 Select Device

W Project Wizard

Project Name

E» Select Device

Select Device

Specify a target device for your project

Summary Filter
Series: GWINSR ~| Package: |QFN48P ~
Device: GW1NSR-4C ~ | Speed: C7/16 ~
Device Version:
Any ~
g no version number is initial version
Search: it |(0 matches)
Part Number Device Device Version Package Speed Voltage
£ >
= Back MNext = Cancel
. L]
3.1.4 Project Creation Completed
Project creation is completed, as shown in Figure 3-4.
Figure 3-4 Project Creation Completed
W Project Wizard *
Summary
Project Name
Select Device Project
Name: gowin_empu
E> Summary Directory: Fi\
Source Directory: F:\gowin_empuisrc
Implementation Directory: F:\.gowin_empuiimpl
Device
Part Number: GWINSR-LV4CON48PC7/IG
Series: GWINSR
Device: GWINSR-4C
Package: QFN48P
Speed: C7/I6
= Back Cancel
IPUG932-2.1E 13(36)




3 Project Template

3.2 Hardware Design

3.2 Hardware Design

Use IP Core Generator to generate Gowin_ EMPU(GW1NS-4C)

hardware design.

Select "Tools > IP Core Generator" in the menu bar or "¢
the IP Core Generator.

" to open

Select " Soft IP Core > Microprocessor System > Hard-Core-MCU >
Gowin_EMPU(GW1NS-4C) 2.0", as shown in Figure 3-5.

Figure 3-5 Select Gowin_EMPU(GW1NS-4C) IP Core

{ GOWIN FPGA Designer - [IP Core Generator] - O
File Edit Project Tools Window Help -8 x
O % & D ®H | @ -
Design F X Target Device: | GWINSR-LVACQN4BPCT/IG
~ 7 gowin_empu - [Fcm3_demo\gowin_.. [
[#] GwiNsR-LvacaN4sPCT/I6 1 .
Name . Versic Gow'n_E M PU
v [ Softlp Co?;
al Information
BackGround Configuration
DSP and Mathematics Type: Gowin_EMPU
Interface and Interconnect Vendor: GOWIN Semniconductor
Memery Control
e Summary
v ::T—::tz::;s Gowin_EMPU is a System-on-Chip FPGA device that embeds MCU hard core,
&% Gowin_EMPU(GW1NS-AC) 2.0 Gowin FPGA Fabric as well as other standard peripherals and featured hard
cores, including 32K-Byte FLASH and configurable 2K-Byte or 4K-Byte or 8K-
Peripheral Byte or 16K-Byte SRAM. The MCU contains a low power, low cost and high-
Soft-Core-MCU performance ARM Cortex-M3 32-bit RISC. The flexible FPGA Fabric serves as
Multimedia user programmable peripherals, or soft-core IPs.
SerDes
< : > v All internal block and sub-block functions of the Gowin_EMPU, including the =
Design Hierarchy Start Page Design Summary IP Core Generator [x]
Message 2 %
Console  Message
The system architecture of Gowin_ EMPU(GW1NS-4C) is as shown in
Figure 3-6.
The grayed modules are the default, and you can not configure; If the
modules are not grayed, you can open the modules to configure.
The modules that you can choose to configure include:
® TPIU
® NVIC: six user interrupt handling signals USER_INT0~5
® AHB2 Slave: FPGA core system can extend AHB2 Slave peripherals.
® AHB2 Master: FPGA core system can extend AHB2 Master
peripherals.
® GPIO
IPUG932-2.1E 14(36)




3 Project Template

3.2 Hardware Design

® UARTO and UART1
® RTC
® The SRAM can be configured as 2KB, 4KB, 8KB or 16KB, 16KB by

default.

® |2C: FPGA core system integrates 1°C Master.

SPI: FPGA core system integrates SPI1 Master.
APB2 Master[1 -12]: FPGA core system can extend twelve APB2

Master user devices.

Figure 3-6 System Architecture

Ay Gowin EMPU

General

Device: [GW1NSR-4C

Part Number: | GWINSR-LV4CQN48GC7/16

Create In:

| F\gowin_empu'src\gowin_empu

File Name: |gmvin_empu| | Module Name: |Gowin_EMPU_Top
Language: Verilog ~
IACU
- - -
TRIU TPIU IF
FPGA Fab ric
i USER INT[0-5]
AHB 2 Slave Bdension | AHB2Slave SRAM
AHBZ Master Bdension
SRAM/FLASH IF
GPIO IF
- Cock/Reset
APB2 Esxtension |F
UARTD IF \L
UARTD
== B e
UART1 IF Master[1-12]
UART1

= |
g,
J me b RTCIF _
=

The system configuration options of Gowin_ EMPU(GW1NS-4C) are

as shown in Table 3-1.

IPUG932-2.1E
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Table 3-1 System Configuration Options

Options

Description

Enable TPIU

Enable TPIU, disabled by default

Enable USER_INT_0

Enable user interrupt handling signal [0], disabled by default.

Enable USER_INT_1

Enable user interrupt handling signal [1], disabled by default.

Enable USER_INT_2

Enable user interrupt handling signal [2], disabled by default.

Enable USER_INT_3

Enable user interrupt handling signal [3], disabled by default.

Enable USER_INT_4

Enable user interrupt handling signal [4], disabled by default.

Enable USER_INT 5

Enable user interrupt handling signal [5], disabled by default.

Enable GPIO

Enable GPIO, disabled by default.

Enable GPIO I/O

Enable GPIO inout port, enabled by default.

Enable UARTO

Enable UARTO, disabled by default.

Enable UART1

Enable UART1, disabled by default.

Enable RTC

Enable RTC, disabled by default.

Enable AHB2 Master

Enable AHB2 Master user extension interface, disabled by default.

Enable AHB2 Slave

Enable AHB2 Slave user extension interface, disabled by default.

Enable 1°C Enable 1°C Master, disabled by default.
Enable I2C I/O Enable I2C inout port, enabled by default.
Enable SPI Enable SPI Master, disabled by default.

Enable APB2 Master 1

Enable APB2 Master [1] user extension interface, disabled by default.

Enable APB2 Master 2

Enable APB2 Master [2] user extension interface, disabled by default.

Enable APB2 Master 3

Enable APB2 Master [3] user extension interface, disabled by default.

Enable APB2 Master 4

Enable APB2 Master [4] user extension interface, disabled by default.

Enable APB2 Master 5

Enable APB2 Master [5] user extension interface, disabled by default.

Enable APB2 Master 6

Enable APB2 Master [6] user extension interface, disabled by default.

Enable APB2 Master 7

Enable APB2 Master [7] user extension interface, disabled by default.

Enable APB2 Master 8

Enable APB2 Master [8] user extension interface, disabled by default.

Enable APB2 Master 9

Enable APB2 Master [9] user extension interface, disabled by default.

Enable APB2 Master 10

Enable APB2 Master [10] user extension interface, disabled by default.

Enable APB2 Master 11

Enable APB2 Master [11] user extension interface, disabled by default.

Enable APB2 Master 12

Enable APB2 Master [12] user extension interface, disabled by default.

SRAM Size

The SRAM Size can be configured as 2KB, 4KB, 8KB and 16KB, 16KB by
default.

IPUG932-2.1E
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3.2.1 TPIU Configuration

Double click TPIU to configure it, as shown in Figure 3-7.

If "Enable TPIU" is selected, Gowin_EMPU(GW1NS-4C) supports

TPIU, disabled by default.

Figure 3-7 TPIU Configuration

TPIU ?

TPIU &

Trace Port Interface Unit, works with debug
infarmation from all trace units, then sends to

extern to capture hardware signals.

o v a2 e Configurations

Configuration

Enable TRIU

Gowin EMPU

Cancel

3.2.2 NVIC Configuration

IPUG932-2.1E

Double click NVIC to configure USER_INT_0~5 for user extension
peripherals of FPGA core system, as shown in Figure 3-8.

If "Enable USER_INT_0" is selected, Gowin_ EMPU(GW1NS-4C)
supports user interrupt handling signal [0], disabled by default.

If "Enable USER_INT_1" is selected, Gowin_ EMPU(GW1NS-4C)
supports user interrupt handling signal [1], disabled by default.

If "Enable USER_INT_2" is selected, Gowin_EMPU(GW1NS-4C)
supports user interrupt handling signal [2], disabled by default.

If "Enable USER_INT_3" is selected, Gowin_EMPU(GW1NS-4C)
supports user interrupt handling signal [3], disabled by default.

If "Enable USER_INT_4" is selected, Gowin_EMPU(GW1NS-4C)
supports user interrupt handling signal [4], disabled by default.
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® [f "Enable USER_INT_5"is selected, Gowin_ EMPU(GW1NS-4C)
supports user interrupt handling signal [5], disabled by default.

Figure 3-8 NVIC Configuration

o NVIC ? *
NVIC &0
iy
There are six user interrupt signals from NVIC of
Gowin EMPU to FPGA Fabric.If user extends soft-
o E core peripherals, USER_INT 0~5 can be as interrupt
ignals f ft- ipherals.
ol signals for soft-core peripherals
] e
—l Options
" ) ~
™ Configuration
—
Enable USER_INT 0
— ]
Enable USER INT 1
™ Enable USER_INT 2
[A Coabla 1ICCD IMT 3 N
Gaowin EMPU

3.2.3 GPIO Configuration

Double click GPIO to configure it, as shown in Figure 3-9.

® [f "Enable GPIO" is selected, Gowin_ EMPU(GW1NS-4C) supports
GPIO, disabled by default.

® [f "Enable GPIO" is selected, you can configure GPIO port type.

® [f "Enable GPIO I/O" is selected, GPIO supports inout port, supported
by default.
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Figure 3-9 GPIO Configuration

' GPIO ? et

GPIO &

Gowin EMPU contains a set of GPIO,which can be
accessed and controlled through AHB bus. The
GPIO block interconnects with the FPGA Fabric
where user implements general purpose I/O

ek [— functions. This AHE GPIO is a general-purpose 1/O
interface unit and provides a 16-bit IO interface.

e [l—
Options
| Enable GPIO
s nable A
Interface:

Enable GPIO 1/O

Gowin EMPU

3.2.4 UART Configuration

Double click UARTO or UART1 to configure it, as shown in Figure
3-10.
® [f "Enable UARTO0" is selected, Gowin_ EMPU(GW1NS-4C) supports
UARTO, disabled by default.

® [f "Enable UART1" is selected, Gowin_ EMPU(GW1NS-4C) supports
UART1, disabled by default.
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Figure 3-10 UART Configuration

"w UARTO/UART1 ? X

UARTO/UART1 oo

asynchronous receiver / transceiver, which can be ~
accessed and controlled through APB1 bus.Both
UART supports maximum BAUD rate at
921.6Kbit/s.

The APB UART supports 8-bit communication
without parity, fixed at one stop bit per
configuration.

Options

Enable UARTO
Enable UART1

Gowin EMPU

Cancel

3.2.5 AHB2 Master/Slave Configuration

Double click AHB2 Master or AHB2 Slave to configure it, as shown in
Figure 3-11.

® [f "Enable AHB2 Master" is selected, Gowin_EMPU (GW1NS-4C)
supports AHB2 Master mode (disabled by default). Through this
interface, FPGA logic peripherals act as slaves, while the MCU
functions as the master.

® \When "Enable AHB2 Slave" is selected, Gowin_ EMPU (GW1NS-4C)
supports AHB2 Slave mode (disabled by default). Through this
interface, the MCU acts as the slave, while the FPGA logic functions as
the master.

® The base address mapping of AHB2 Master user extension
peripherals is 0xA0000000.
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Figure 3-11 AHB2 Master/Slave Configuration

' AHB2 Master/Slave ? X

AHB2 Master/Slave &

The user can extend AHB2 bus to support a high speed peripheral as master, or support
Gowin_EMPU as a slave.Extend AHB2 bus to FPGA fabric, user can design AHB2 high speed
peripherals soft core as master or design Gowin_EMPU as high speed slave.

Options

hsae{20]

st hbumtizn)

AHB2 Master

AHB2 Master Address Size(KB)
Enable AHB2 Master 0xAC000000 64
AHB2 Slave

Enable AHB2 Slave

I R AR B R 2N 2 N B
O O 0 I i o o o e

Gowin EMPU

3.2.6 SRAM Configuration

Double click SRAM to configure SRAM Size, as shown in Figure 3-12.

The SRAM Size can be configured as 2KB, 4KB, 8KB or16KB, 16KB
by default.
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Figure 3-12 SRAM Configuration

% SRAM 7 x
Wi
SRAM 57
There are four SRAM sizes for Gowin_EMPU.First size is
2KB, uses one BSRAM as SRAM.Second size is 4KB,
uses two BSRAM as SRAM.Third size is 8KB, uses four
BSRAM as SRAM.The other size is 16KB, uses eight
BSRAM as SRAM.The default size is 16KB.
e
—_] Optians
. P
Configuration
SRAM Size:
Gowin EMPLU

3.2.7 I>C Configuration

Double click I°C Master to configure it, as shown in Figure 3-13.

® |[f "Enable I°C" is selected, Gowin_EMPU(GW1NS-4C) supports I°C

Master, disabled by default.

If "Enable 12C" is selected, you can configure I1°C Master port type.

® |[f "Enable 12C I/O" is selected, 1°C Master supports inout port,

supported by default.

IPUG932-2.1E
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Figure 3-13 I2C Configuration

& ec ? *

12C &

Gowin EMPU contains a 12C block, which can be
accessed and controlled through APB2 bus. The
12C Block is a fully verified block which can
implement 12C communication. The 12C block
implements 12C protocol.

Options

Enable 12C ”~
Interface:

Enable 12C I/O

Gowin EMPU

3.2.8 SPI Configuration

Double click SPI Master to configure it, as shown in Figure 3-14.

If "Enable SPI" is selected, Gowin_ EMPU(GW1NS-4C) supports SPI
Master, disabled by default.

Figure 3-14 SPI Configuration

& SPI ? x

SPI &

Gowin_EMPU contains a SPI block, which can be
accessed and controlled through APBZ bus. The SPI
Block is a fully verified block which can implement
SPI communication. The SPI block implements SPI

R — e protocal.
— s N
Options
. — .
, A
Configuration
Enable SPI
v

Gowin EMPU
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3.2.9 RTC Configuration

Double click RTC to configure it, as shown in Figure 3-15.

If "Enable RTC" is selected, Gowin_ EMPU(GW1NS-4C) supports
RTC, disabled by default.

The port rtc_src_clk is input a 3.072MHz clock, internally divided by
the RTC to 1Hz.

Figure 3-15 RTC Configuration

" RTC ? X

RTC &

Gowin_EMPU contains a real time clock block, which
can be accessed and controlled through APB1 bus,
The RTC block is a fully verified block which can
implement real time clock.

Options

Configuration

Enabel RTC

W

Cancel

Gigryin EMPU

3.2.10 APB2 Master Configuration

Double click APB2 Master[1 -12] to configure it, as shown in Figure
3-16.

® [f "Enable APB2 Master 1" is selected, Gowin_ EMPU(GW1NS-4C)
supports APB2 Master [1], disabled by default.

® [f "Enable APB2 Master 2" is selected, Gowin_ EMPU(GW1NS-4C)
supports APB2 Master [2], disabled by default.

® [f "Enable APB2 Master 3" is selected, Gowin_ EMPU(GW1NS-4C)
supports APB2 Master [3], disabled by default.

® [f "Enable APB2 Master 4" is selected, Gowin_ EMPU(GW1NS-4C)
supports APB2 Master [4], disabled by default.

® [f "Enable APB2 Master 5" is selected, Gowin_ EMPU(GW1NS-4C)
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supports APB2 Master [5], disabled by default.

® [f "Enable APB2 Master 6" is selected, Gowin_ EMPU(GW1NS-4C)
supports APB2 Master [6], disabled by default.

® [f "Enable APB2 Master 7" is selected, Gowin_EMPU(GW1NS-4C)
supports APB2 Master [7], disabled by default.

® [f "Enable APB2 Master 8" is selected, Gowin_EMPU(GW1NS-4C)
supports APB2 Master [8], disabled by default.

® [f "Enable APB2 Master 9" is selected, Gowin_ EMPU(GW1NS-4C)
supports APB2 Master [9], disabled by default.

® [f "Enable APB2 Master 10" is selected, Gowin_ EMPU(GW1NS-4C)
supports APB2 Master [10], disabled by default.

® [f "Enable APB2 Master 11" is selected, Gowin_ EMPU(GW1NS-4C)
supports APB2 Master [11], disabled by default.

® [f "Enable APB2 Master 12" is selected, Gowin_ EMPU(GW1NS-4C)
supports APB2 Master [12], disabled by default.

Figure 3-16 APB2 Master[1-12] Configuration

APB2 Master[1-12]

APB2 Master[1-12]

? >
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Gowin EMPU

Gowin_EMPU contains 12 APB2 Master extension interface, which can be accessed and controlled
through APB2 bus. The APB2 Master [1-12] extension block is a fully verified black which can extend
APB bus to user to design more APB peripherals.

Options

Configuration

APB2 Master Address Size(Byte)
Enable APB2 Master 1 0X40002400 256
Enable APB2 Master 2  0X40002500 256
[] Enable APB2 Master 3 0X40002600 256
[] Enable APB2 Master 4  0X40002700 256
[[] Enable APB2 Master 5 0X40002800 256
[] Enable APB2 Master 6 0X40002900 256
[] Enable APE2 Master 7 0X40002A00 256
[] Enable APE2 Master 8 0X40002B00 256
[] Enable APE2 Master 9 0X40002C00 256

[] Enable APB2 Master 10 0X40002D00 256

[] Enable APB2 Master 11 0X40002E00 256 R

Cancel

IPUG932-2.1E

The base address mapping of APB2 Master [1-12] user extension
peripherals is as shown in Table 3-2.
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Table 3-2 Base Address Mapping of APB2 Master [1-12]

APB2 Master Address Size(Byte)
1 0x40002400 256
2 0x40002500 256
3 0x40002600 256
4 0x40002700 256
5 0x40002800 256
6 0x40002900 256
7 0x40002A00 256
8 0x40002B00 256
9 0x40002C00 256
10 0x40002E00 256
11 0x40002E00 256
12 0x40002F00 256

3.2.11 PSRAM Memory Interface

If the GW1INSR-4C MG64P is selected, Gowin_ EMPU (GW1NS-4C)
supports the FPGA core system extended external device PSRAM
Memory Interface.

The software development kit provides the external device PSRAM
Memory Interface as a reference design.

Hardware Design Flow

® [P Core Generator is used to configure and generate Gowin_EMPU
(GW1NS-4C) IP Core, and the AHB2 Master user extension interface
is enabled.

® [P Core Generator is used to configure and generate PSRAM Memory
Interface HS IP Core.

- Memory Clock 100MHz
- For other options, you can select default configuration.

® Design the AHB PSRAM Memory Interface HS IP implementing the
AHB bus interface, refer to gw_ahb_psram.v.

® |[nstantiate Gowin_EMPU(GW1NS-4C) Top Module and AHB PSRAM
Memory Interface Top Module.

® Connect Gowin_EMPU(GW1NS-4C) to AHB interface of AHB PSRAM
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Memory Interface.
Reference Design
You can click here to get the following reference design:

® Hardware Reference Design ---
\ref_design\FPGA_RefDesign\DK_START_GW1NSR4C_MG64P_V1.
1\gowin_empu\cm3_psram_demo

® Software Programming Reference Design

- ...\ref_design\MCU_RefDesign\MDK_RefDesign\cm3_demo\proje
ct\psram

- ...\ref_design\MCU_RefDesign\GMD _RefDesign\cm3_demo\proje
ct\psram

3.2.12 HyperRAM Memory Interface

IPUG932-2.1E

If the GW1NSR-4C or GW1NSER-4C QN48P is selected,
Gowin_EMPU (GW1NS-4C) supports the FPGA core system extended
external device HyperRAM Memory Interface.

The software development kit provides the external device HyperRAM
Memory Interface as a reference design.

Hardware Design Flow

® [P Core Generator is used to configure and generate Gowin_EMPU
(GW1NS-4C), and AHB2 Master user extension interface is enabled.

® [P Core Generator is used to configure and generate HyperRAM
Memory Interface embedded IP Core.

- Memory Clock 100MHz
- For other options, you can select default configuration.

® Design AHB HyperRAM Memory Interface IP implementing the AHB
bus interface, refer to gw_ahb_hyperram.v.

® Instantiate Gowin_ EMPU(GW1NS-4C) Top Module and AHB
HyperRAM Memory Interface Top Module.

® Connect Gowin_ EMPU(GW1NS-4C) to AHB interface of AHB
HyperRAM Memory Interface.

Reference Design
You can click here to get the following reference design:

® Hardware Reference Design
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\ref_design\FPGA_RefDesign\DK_START_GW1NSR4C_QN48P_V1.
1\gowin_empu\cm3_hyperram_demo

® Software Programming Reference Design

- ...\ref_design\MCU_RefDesign\MDK_RefDesign\cm3_demo\proje
ct\hyper_ram

- ...\ref_design\MCU_RefDesign\GMD_RefDesign\cm3_demo\proje
ct\hyper_ram

3.2.13 SPI-Flash Memory

IPUG932-2.1E

If the GW1INSR-4C or GW1NSER-4C QN48G is selected,
Gowin_EMPU (GW1NS-4C) supports the FPGA core system extended
external device SPI-Flash Memory.

The software development kit provides the external device SPI-Flash
Memory as a reference design.

Hardware Design Flow

® You can configure and generate Gowin_EMPU (GW1NS-4C) IP Core
using IP Core Generator, and APB2 Master [1] user extension interface
is enabled.

® Design SPI-Flash Memory IP, refer to gw_spiflash.v.

® Design APB SPI-Flash Memory IP implementing the APB bus interface,
refer to gw_spiflash.v.

® Instantiate Gowin_ EMPU(GW1NS-4C) Top Module and APB
SPI-Flash Memory Top Module.

® Connect Gowin_ EMPU(GW1NS-4C) to APB interface of APB
SPI-Flash Memory.

Reference Design
You can click here to get the following reference design:

® Hardware Reference Design ---
\ref_design\FPGA_RefDesign\DK_START_GW1NSR4C_QN48G_V1.
1\gowin_empu\cm3_spiflash_demo

® Software Programming Reference Design

- ...\ref_design\MCU_RefDesign\MDK_RefDesign\cm3_demo\proje
ct\spi_flash

- ...\ref_design\MCU_RefDesign\GMD_RefDesign\cm3_demo\proje
ct\spi_flash
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3.3 User Design
® After configuration, you can generate Gowin_ EMPU(GW1NS-4C) IP
Core.
® Instantiate Gowin_ EMPU(GW1NS-4C) Top Module.
® Import user design and connect it with Gowin_ EMPU(GW1NS-4C) Top

Module to form a complete RTL design.

3.4 Constraint

After RTL design is completed, physical constraints can be generated
according to the used development board and the 10.

Timing constraints file can be generated according to timing
requirements.

For the details on physical constraints generation, please refer to
SUG940, Gowin Design Timing Constraints Guide, SUG935, Gowin
Design Physical Constraints Guide.

3.5 Configuration

3.5.1 Synthesize Configuration

The "Synthesize" configuration is as shown in Figure 3-17.

® Configure "Top Module/Entity" according to the top module name in the
design.

® Configure "Include Path" according to the file path in the design.

® Configure Verilog Language, such as System Verilog 2017.

IPUG932-2.1E 29(36)



http://cdn.gowinsemi.com.cn/SUG940E.pdf
http://cdn.gowinsemi.com.cn/SUG935E.pdf
http://cdn.gowinsemi.com.cn/SUG935E.pdf

3 Project Template

3.5 Configuration

Figure 3-17 Synthesize Configuration

A Configuration *
Synthesize
v Global General
General Synthesis Tool: ® GowinSynthesis
Constraints Top Module/Entity: |cm3_dem0 |
~ Synthesize
General Include Path: | |
“ Place & Route TelPre | |
General
Voltage GowinSynthesis
Place Verilog Language: | System Verilog 2017
Route
Dual-Purpose Pin Lespinet 2000 =
Unused Pin [] Show All Warnings
¥ BitStream [] Disable Insert Pad
General [1 Ram R/W Check
sysContral
Feature sysControl
. .
3.5.2 Place Configuration
. " n . H '
Configure the "Place" option as shown in Figure 3-18.
Figure 3-18 Place Configuration
A Configuration *
Place
v Global
oba Category: |All w Reset all to default
General
Constraints Label Value
~ Synthesize Place input registers to 10B True
General Place output registers to 10B True
¥ Place & Route Place inout registers to 10B True
General Place Option 0
Vaoltage
FPlace
Route

Dual-Purpose Pin
Unused Pin

v BitStream
General
sysContral

Feature sysControl

Apply

IPUG932-2.1E
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3.5.3 Route Configuration

Configure the "Route" option as shown in Figure 3-19.

Figure 3-19 Route Configuration

A Configuration *
Route
v Global
oba Category: |All - Reset all to default
General
Constraints Label Value
“ Synthesize Clack Route Order 0
General Run Timing Driven True
v Place & Route Route Option 0
G |
Enera Route Maxfan 23
Voltage R
Correct Hold Viclation True
Place
Route

Dual-Purpose Pin
Unused Pin

~ BitStream
General

sysControl

Feature sysControl

Cancel Apply

3.5.4 Bitstream Configuration

Configure the "Bitstream" option as shown in Figure 3-20.
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Figure 3-20 Bitstream Configuration

A Configuration *

BitStream

v Global Enable CRC Check
General

. Enable Compress
Constraints u =

v Synthesize Enable Security Bit
General Secure Mode

¥ Place & Route Power On Reset Monitor
General

Print BSRAM Initial Value

Voltage
Place Bitstream Format: | Text
Route

Dual-Purpose Pin
Unused Pin

“ BitStream
General
sysControl

Feature sysControl

Cancel Apply

3.6 Synthesize

Run GowinSynthesis to complete the synthesis of RTL design to
generate post-synthesis netlist file, as shown in Figure 3-21.

Figure 3-21 Synthesize

{4 GOWIN FPGA Designer - [CA\Users\liukal\Desktop\em3_demo\impl\gwsynthesis\cm3_demo_syn.rpt.html] - o X
7 Hle Edit Broject Tools Window Help 2 ik
™ = T R =
] 2 &3 % ok uiﬂa@ﬂw e «
Process 8 x Synthesis Details -
&

i | Design Summary

- . Synthesis Messages
v [ User Constraints Vi g Top Level Module cm3_demo
| FloorPlanner Synthesis Details Running parser:
=3 CPU time = 0Oh Om 0.109s,
% Timing Constraints Editor Resource Elapsed time = Oh Om 0.116s, Peak
memory usage = 176.891MB
v O Synthesize Resource Usage Summary Running netlist conversion:
on i CPU time = 0h Om 0s, Elapsed
£ Synthesis Report Resource Utilization Summary time = Ob 0 05, Pask memgw
“ Netlist Fi Timing usage = OMB
etist Hle Running device independent
~ Place & Route Clock Summary optimization:
Optimizing Phase 0: CPU time =
Place & Route Report Max Frequency Summary 0h Om 0s, Elapsed time = 0h 0m
B P ; 0.001s, Peak =
Timing Analysis Report Detail Timing Paths Informations 17583’1!‘:; memory usage
Ports & Pins Report Optimizing Phasa‘l: CPU time =
Oh Om 0s, Elapsed time = 0h Om -
Power Analysis Report ) Smnts Moo e »
Design  Process  Hierarchy 7 Start Page Design Summary 2t em3 demo_synepthtml £ L7 em3_demo.vg
Console 8 %
Ty G .
[55%] Inferring Phase 3 completed

Running technical mapping ...

[60%] Tech-Mapping Phase @ completed
[65%] Tech-Mapping Phase 1 completed

[75%] Tech-Mapping Phase 2 completed

[80%] Tech-Mapping Phase 3 completed

[90%] Tech-Mapping Phase 4 completed

[95%] Generate netlist file "C:\Users\liukai\Desktop\cm3_demo\impligwsynthesis\cm3_demo.vg" completed

[10@%] Generate report file "C:\Users\liukai\Desktopicm3_demol\impligwsynthesis\em3_demo_syn.rpt.html” completed
GowinSynthesis finish

%

Console  Message

For the tool usage, please refer to SUG100, Gowin Software User
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3.7 Place & Route

Guide.

3.7 Place & Route

Run the Place & Route tool in Gowin software and generate the
bitstream file, as shown in Figure 3-22.

Figure 3-22 Place & Route

A7 GOWIN FPGA Designer - [CA\Users\liukaf\Desktop\cm3_dema\impl\pnricm3_dema.rpthtml] — [u} %
7 Ele Edit Project Tools Window Help -8 x
v B | 52 u = B |
] A BSHED@®HR GEE S
Process s % PnR Details
|| Design Summary
~ F User Constraints PnR Messages Running placement: .
&+ il Placement Phase 0: CPU time = Oh Om 0.007s, Elapse:
& FloorPlanner PnR Details P:acement Ppase 1: CPU time = Dp om 0.062s, E}apse;
— Placement Phase 2: CPU time = Oh Om 0.001s, Elapses
% Timing Constraints Editor Resource Placement Phase 3: CPU time = Oh Om 0.735s, Elapset
. Total Placement: CPU time = Oh Om 0.805s, Elapsed ti
v @ syrthesize Resource Usage Summary Runming reuting: P
- Place & Route Process ; . . _ __
= Synthesic Report I/0 Bank Usage Summary Rnut]ng Phase 0: CPU t!rne = 0h Om 0s, Elapsed time 1
Routing Phase 1: CPU time = Oh Om 0.062s, Elapsed ti
= Netlist File Clock Resource Usage Summary Routing Phase 2: CPU time = Oh Om 0.093s, Elapsed i
. . Routing Phase 3: CPU time = 0h Om 0s, Elapsed time -
~ (@ Place & Route Global Clock signals Total Routing: CPU time = Oh Om 0.1555, Elapsed time
— Pinout by Port Name Generate output files:
Place & Route Report v CPU time = Oh Om 0.793s, Elapsed time = Oh Om 0.79
= Timi i All Package Pins
Timing Analysis Report 9 Total Time and Memory Usage CPU time = Oh Om 2s, Elapsed time = Oh Om 2s, Peak m
= Ports & Pins Report
Power Analysis Report v 4 »
Design  Process  Hierarchy Start Page Design Summary ! em3_dema_syn.rpthtml cm3_demorpthtml [0
Consale g X

—
Bitstream generation in progress......
Bitstream generation completed
Running power analysis......

[180%] Power analysis completed

Generate file
Generate file
Generate file
Generate file
Generate file

Fri May 16 15:15:24 2825

"C:\Users\liukai\Desktop\cm3_demo\impl\pnricm3_demo.power.html" completed
"C:\Users)liukai\Desktop\cm3_demo\impl\pnricm3_demo.pin.html" completed
"C:\Users\liukai\Desktop\cm3_demo‘\implipnricm3_q

demo.rpt.html” completed

"C:\Users\liukai\Desktop\cm3_demo\impl\pnricm3_demo.rpt.txt" completed
"C:\Users\liukai\Desktop\cm3_demo\impl\pnricm3_demo.tr.html” completed

%

Consale

Message

For the tool usage, please refer to SUG100, Gowin Software User

Guide.

3.8 Download

IPUG932-2.1E

Download the bitstream file using Gowin Programmer.

Open Programmer in Gowin software or under the installation path.

Click "Edit > Configure Device" on the menu bar or "Configure Device"
() on the tool bar to open the "Device configuration".

If the GW1NS-4C or GW1NSR-4C is selected, configuration options
are as shown in Figure 3-23.

® Select "MCU Mode" in "Access Mode" drop-down list.

® Select "Firmware Erase, Program" or "Firmware Erase, Program,
Verify" in "Operation" drop-down list.
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3.8 Download
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Figure 3-23 Download Configuration for GW1INS-4C/GWINSR-4C

¥ Device configuration ? *

Device Operation
hocess Mode: MCU Mode v

Operation: Firmware Erase, Frogram w

Firmware Eraze, Frogram

Frogramming Options

File name: |F:/gowin_empu/impl/por/zowin_empu. f5

User Flash Initialization

FMCU/Binary Input Optiens

Firmware/Binary File: _demofprojectfspi_ﬂashfmd]{_vEfspi_ﬂash.binl D

Save Cancel

If the GW1NSER-4C is selected, configuration options are as shown

in Figure 3-24.

® Select "SecureFPGA Mode" in "Access Mode" drop-down list.

® Select "Firmware Erase, Program Securely" in "Operation" drop-down

list.

Figure 3-24 Download Configuration for GWINSER-4C

{4 Device configuration ? >

Tevice Operation
focess Mode: Secur eFPGA Mode LY

Operation: Firmware Eraze, Frogram Securely w

Firmware Erase, Program, Yerify with Security(0ne Time Programmable For
Kew Authentication Code)

Programming Options

File name: |F:/gowin_empu/impl/pre/gowin_empu. fz

Uzser Flash Initialization

Y MU Binary Input Options

Firmware/Finary File: _demc-fpro_ie-:tfspi_ﬂash/mdk_vE!spi_ﬂash.b:i.nl D

Save Cancel

® Import hardware design bitstream file in "Programming Options > File
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3 Project Template 3.8 Download

name".
® Click "Save" to complete the configuration.

Note!

Import software executable file using " FW/MCU Input Options > Firmware/Binary File"
option, and you can refer to IPUG928, Gowin EMPU(GW1NS-4C) IDE Software

Reference Manual.

After device configuration, click Program/Configure "“©" on the
Programmer tool bar to complete downloading of hardware design
bitstream file and software executable file.

For the usage of Programmer, you can refer to SUG502, Gowin
Programmer User Guide.
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4 Reference Design

4 Reference Design

Gowin_ EMPU(GW1NS-4C) provides hardware reference design in
Gowin Software (V1.9.11.02 (64-bit), tested). You can click here to get the
following reference design.

® . .\ref design\FPGA RefDesign\DK_START _GW1NSR4C_MG64P_V
1.1\gowin_empu\cm3_psram_demo

® . .\ref_design\FPGA_RefDesign\DK_START_GW1NSR4C_QN48G_V
1.1\gowin_empu\cm3_spiflash_demo

® . .\ref _design\FPGA_RefDesign\DK_START_GW1NSR4C_QN48P_V
1.1\gowin_empu\cm3_ahb2_demo

® . .\ref _design\FPGA_RefDesign\DK_START_GW1NSR4C_QN48P_V
1.1\gowin_empu\cm3_ahb2_slave_demo

® . .\ref design\FPGA RefDesign\DK_START_GW1NSR4C_QN48P_V
1.1\gowin_empu\cm3_apb2_demo

® . .\ref design\FPGA RefDesign\DK_START_GW1NSR4C_QN48P_V
1.1\gowin_empu\cm3_demo

® . .\ref design\FPGA RefDesign\DK_START_GW1NSR4C_QN48P_V
1.1\gowin_empu\cm3_fifo_demo

® . .\ref_design\FPGA_RefDesign\DK_START_GW1NSR4C_QN48P_V
1.1\gowin_empu\cm3_hyperram_demo

® . .\ref_design\FPGA_RefDesign\DK_START_GW1NSR4C_QN48P_V
1.1\gowin_empu\cm3_userint_demo

® ...\solution\RTOS\ref design\FPGA _RefDesign\gowin_empu

® ...\solution\RunInSRAM_FromEmbFlash\ref _design\FPGA_RefDesign
\gowin_empu

® ...\solution\RunInSRAM_FromSIPFlash\ref_design\FPGA_RefDesign\
gowin_empu
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